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In this Master Thesis the characteristics of the chosen fractal microstrip antennas are 

investigated. For modeling has been used the structure of the square Serpinsky fractal 

curves. During the elaboration of this Master thesis the following steps were 

undertaken: 

1) calculation and simulation of square microstrip antennа, 

2) optimizing for obtaining the required characteristics on the frequency 2.5 GHz, 

3)  simulation and calculation of the second and third iteration of the Serpinsky 

fractal curves, 

4)  radiation patterns and intensity distribution of these antennas.  

In this Master’s Thesis the search for the optimal position of the port and fractal 

elements was conducted. These structures can be used in perspective for creation of 

antennas working at the same time in different frequency range. 

  



3 

 

 Contents 

List of acronyms and abbreviations .......................................................................... 4 

Introduction. .............................................................................................................. 5 

1.Theory .................................................................................................................... 6 

1.1Antennas ........................................................................................................... 6 

1.2 Microstrip antennas ......................................................................................... 6 

1.3 The theory of fractals. ..................................................................................... 9 

1.4 Fractal curves ................................................................................................ 13 

1.5 Fractal Antenna ............................................................................................. 15 

1.6 Application and results.................................................................................. 20 

2. Antenna measurement ......................................................................................... 21 

2.1 The means of antenna measurement ............................................................. 21 

3.Design in ANSYS HFSS ...................................................................................... 24 

3.1 Overview of the design ................................................................................. 24 

3.2 Main characteristics of the package Ansoft HFSS ....................................... 25 

3.3 Modeling of antennas in HFSS ..................................................................... 26 

4 Model with the use of the second and third iteration Sierpinski fractal 

square ...................................................................................................................... 45 

4.1 The second iteration ...................................................................................... 45 

4.2 The third iteration .......................................................................................... 49 

Conclusion ............................................................................................................... 53 

REFERENCES ........................................................................................................ 54 

 

 

  



4 

 

List of acronyms and abbreviations 

 

MPA – Microstrip Printed Antenna 

RP – Radiation Pattern 

AFU - Antenna-Feeder Unit 

ASL - Asymmetric Stripline  

LH – Left-Handed 

ESA - Electrically Small Antenna 

SFC - Sierpinski Fractal Carpet Antenna 

FEM –Finite Element Method  

HFSS- High Frequency System Stimulator 

  



5 

 

Introduction 

 

 

The development of mobile telecommunication technology, radar 

and microwave pickoff necessitates the development of new multi-element 

antenna systems consisting of emitters  with small dimensions and optimal 

configuration. The most common types of emitters are square microstrip 

printed antenna (MPA), the benefits of which are light weight, ease of 

production, ability to be integrated  into  microwave circuit and simplicity 

to achieve both linear and circular polarizations. The main drawbacks of 

the MPA are narrowband resonant character as a consequence, as well as 

being large enough to impede their integration into arrays with a large 

scanning angle radiation  pattern (RP). An alternative way of reducing the 

size of the MPA is to optimize the geometry of the MPA based on fractal 

technology. 

The theory of the interaction of electromagnetic waves with fractal 

antennas was developed recently and intensively. Striking examples of this 

are the main trends in the development of ultra-wideband or multi-band 

antennas. The properties of these antennas and their characteristics, 

namely: input impedance, radiation pattern and antenna directivity vary 

within specified limits in a very wide frequency band. Antennas based on 

fractal structures efficiently emit and receive electromagnetic energy over a 

wide frequency range. Moreover, in simple, equal conditions, antenna size 

can be reduced. This effect is due to the iterative process of its formation, 

since at each iteration the physical length of the conductors increases, and 

thus increases the electrical length of the antenna. 

This paper presents the results of the development of fractal MPA, 

giving their comparison with traditional square MPA.  
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1. Theory 

 

1.1 Antennas 

 

Antennas are in present usage. They are used in radio and television, 

for communication, navigation and positioning, and in radar beacons in 

satellite technology, astronomy and medicine [1]. 

In modern conditions, antenna technology is one of the fastest 

growing areas of electronics. Recent advances in the technology of 

antennas are based on the latest developments of the electronics, 

semiconductor technology, coherent radio optics, optoelectronics, etc. 

Various objects, both ground and aircraft have different ranges of multiple 

antennas and appointments, and electromagnetic compatibility depends on 

the characteristics and parameters of the antenna [2]. 

One of the main trends in the development of modern 

telecommunications technology is the miniaturization of radioelectronic 

apparatus. It is known that the characteristics of radioelectronic apparatus is 

largely determined by the properties and structural and electrical properties 

of its antenna-feeder unit (AFU). 

Microstrip antennas (MPA) provide high repeatability size, low cost, 

low metal consumption, dimensions, weight.  

Now I will consider further what microstrip antennas are. 

1.2 Microstrip antennas 

 

Strip lines, i.e. line or lines on the basis of printed circuit techniques, 

as compared with conventional types of lines are small in volume and 

weight and stand out for their low cost of manufacture. Figure 1.1 shows 

the five main types of striplines. 
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Figure 1.1 The main types of strip lines: (a) symmetric stripline; (b) asymmetric 

stripline; (c) asymmetric stripline with dielectric top layer; (d) three-layered line,(e) 

three-layered line with low  losses. Types C and D are also called "sandwich" lines 

 

Outer boundary strip lines currently reach approximately 10 GHz. 

Their use is restricted mainly to the power density. Stripline or structural 

elements in a strip version are used most often where small volume and 

weight, and temperature stability are important [3]. 

For the wave resistance of the strip line is generally true: 

ZL=
 

  
 
√ 

 
         (1) 

 Where υ is phase velocity of the L wave in the  line;  

C is linear capacitance (capacitance per unit length);  

L is linear inductance (inductance per unit length). [4] 
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Typically, the strip lines are made in the form of thin metal layers on 

dielectric sheets. As the dielectric material with low losses in the 

microwave is used:  polyethylene, ceramics, aluminum dioxide, sapphire, 

quartz, ferrites, etc. Sometimes air is used to fill the lines. In the 

manufacture of strip lines either foil dielectrics are used or metal strips are 

applied to the surface of a dielectric thin film or thick film using the 

technology. 

The fundamental waves in the strip lines usually are the TEM wave 

or quasi-TEM wave in the structure and other properties of the field close 

to the TEM wave. 

Asymmetric stripline (ASL) is a two wire stripline consisting of a 

strip of width w and thickness t, placed at a distance H from a shielding 

plate having a width a. The space between the conductors and above the 

strip is filled with dielectric material with parameters εr, μr = 1, ϭD. The 

current-carrying elements (strip and screen) are made of metal with a 

conductivity ϭM. 

In practice is widely used a slightly modified design, called a 

microstrip line. It differs from the ASL in that between the strip and the 

shielding plate is placed a substrate with dielectric parameters εr2 and μr2 = 

1, ϭd2; above the bar is a dielectric with parameters εr1, μr1 = 1, ϭd1. 

Typically, air fills the space above the strip (εr, 1 = 1, ϭ d = 0). If we 

compare the energy transfer on the ASL and the MSL, the MSL in the 

energy level of the radiation to the surroundings is much lower than in the 

ASL, due to the increasing concentration of the electromagnetic field in the 

dielectric substrate, particularly for large values εr2 [3]. 

Microstrip antennas (MPA), manufactured by IC technology, provide 

high repeatability size, low cost, low metal consumption, dimensions, 

weight. [3] 



9 

 

Microstrip antenna can emit energy with linear, circular and elliptical 

polarization. There are some easy design solutions for the operation in a 

two or multi-frequency modes, which makes it easy to combine many of 

elementary radiators in phased array and place them on the surfaces of 

complex shape. Furthermore, microstrip antennas have a high aerodynamic, 

mechanical, and thermal properties [3]. 

Major advances in the practice of the microstrip planar antenna are 

associated with the two-dimensional structures. These are emitters in the 

form of metal structures correct or incorrect geometric shapes arranged on 

a dielectric layer with a metal screen. 

Excitation of such antennas is provided by coaxial or strip lines 

(Figure 1.2). In the second case there is a very compact design, in addition 

to the antenna on board deployment of emission control or signal 

processing circuits is possible [3]. 

 

Figure 1.2 Excitation of the MSA. a) from the coaxial line; b) from MSL 

1.3 The theory of fractals 

Fractals are called geometric objects: line, surface, spatial body with 

highly rugged form and is self-similar [5]. 

The term "fractal" refers to a geometric configuration which is 

characterized by the endless repetition of the same tog "pattern." Enlarged 

or reduced in any number of times. So appear characteristic of self-

similarity property of fractals [6]. 
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Fractal theory considers measures instead of integers  fractional and 

is based on new quantitative indicators in the form of fractional dimension 

D and the corresponding fractal signatures. 

D0 is topological dimension of the space, which is considered a fractal with 

fractional dimension D [7]. 

 

Figure 1.3 The development of new research methods [6]. 
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Figure 1.4 Classification and morphology of fractal sets and fractal signatures. 

 

Unlike traditional methods, when smooth synthesized antenna 

pattern, based on fractal theory is the idea of synthesis of the 

implementation of radiation characteristics of a repetitive structure are on 

an arbitrary scale. 

The work of the fractal antenna geometry is achieved through 

conductors, and not through the accumulation of components (as in 

classical antennas). This gives one the opportunity to create new modes of 

fractal electrodynamics and to receive fundamentally new properties [7]. 

Based on nanotechnology physical modelling of fractional integral 

and differential operators permits the creation of passive radioelements, 
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fractal modeling impedances )(Z  with frequency scaling )(Z   )( jA , 

where 0  1, A is constant and   is the angular frequency. For this a 

model was created infinite continued fraction in the form of impedance 

)(Z . In the case of the final stage of construction, when we use the n-th 

convergents of this continued fraction, the frequency ranges can be 

controlled and there will be   type power-law dependence of the 

impedance. In this case, we first realize "fractal capacitor [7]. 

Based on the results [7], we can talk about the design of 

fundamentally new fractal elements (devices) and fractal radio Fig. 1.5 [7]. 

 

 

Figure 1.5 The concept of fractal radio systems and devices. 

 

Fractal radios include  fractal antenna and digital fractal detectors 

based on fractal information processing methods, and can also use methods 

of fractal modulation / demodulation. Fractal methods can function at all 

"levels" of the signal: amplitude, frequency, phase, polarization, etc. [7] 
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1.4 Fractal curves 

Fractal curves have been known since the late 19th century. They are 

generated in an iterative manner by sequentially repeating one after the 

other geometrical shape (which is often a set of scaled copies of the first 

form). After each iteration  the fractal curve of higher order is longer than 

the previous one, it is better to fill the area in which it is generated. This 

property provides a space-filling high potential for miniaturization of 

passive microwave circuits because, theoretically, the use of fractal curves 

allows the design of infinite wavelength lines in the final area of the 

substrate. [8] 

Recent results have shown that the application of fractal curves leads 

to  very solid compact microstrip resonators and filters, which surpass all 

other nonfractal solutions. This is due to an increase in the overall length of 

the microstrip line on a predetermined region of the substrate as well as the 

particular geometry of the line. [8] 

Fractal geometry has also been used for the design of the wires. It is 

used in applications such as miniature antennas, frequency selective 

surfaces, the surface with high resistance, LH metamaterials, radio 

frequency identification. In metamaterial structures, the most effective 

medium is formed by inserting a large number of identical subwavelength 

fractal-shaped inclusions within the host environment. Advanced class 

wired structures, filling the space-based grid schedule Hamiltonian paths 

and cycles have also been investigated. The possibility of practical 

application of the results mentioned above is provided in the design of thin 

screens and absorbing the earth's surface for antennas. Nevertheless, they 

are not directly applicable to the design of a split ring, because in the latter 

case, it requires some additional characteristics of fractal curves [8]. 
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Fractal curves are characterized by a fractal dimension, that is not an 

integer. The fractal dimension of each curve is a number between 1 and 2 

and can be understood as a measure of the ability of spatial filling fractal 

curve [8]. 

Currently, there is a large number of known fractal curves. In an 

attempt to define which fractal curve will be more suited to this application 

some criteria were introduced. In order to further miniaturization, the 

fractal dimension is selected as the most important characteristics. The 

higher the fractal dimension, the better the fractal curve fills this area, and 

this achieves higher compactness [8]. 

There are three fractal curves with a fractal dimension equal to 2 (ie, 

the maximum value): Peano, Hilbert and square Sierpinski fractals. 

 

Figure 1.6 Fractal curves with dimension equal to 2 (a) Peano (b) Hilbert (c) Square 

Sierpinski. 

 

Fractals Peano and Hilbert are open curves, which have ends on 

different sides, they are suitable for use in structures such as finite coupled 

microstrip resonators or metasurfaces [8]. 

Square Sierpinski fractal consists of squares that fill the field. In the 

case of square Sierpinski fractal the outer and inner squares overlap, 

thereby creating a denser structure [8]. 
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Figure 1.7 Generation of square Sierpinski fractal. The first three iterations. 

 

Figure 1.8 shows the Sierpinski fractal curves of the second order, 

where a,b and g denotes the size of its segments. According to the rule of 

square fractal generation Sierpinski obtain the following relation: b = 3g, a 

= 2g [9]. 

 

 

Figure 1.8 (a) Sierpinski fractal curves of the second order. 

 

 

1.5 Fractal Antenna 

 

Fractal Antennas are a relatively new class of electrically small 

antennas (ESA), which fundamentally differ from the geometry of known 

decisions. In fact, the evolution of the traditional antennas is based on 

Euclidean geometry dealing integral dimension objects (line, circle, ellipse, 

paraboloid, etc.). The main difference between fractal geometric shapes is 

their fractional dimension that manifests itself outwardly in a recursive 

repetition in increasing or decreasing the extent of the initial deterministic 
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or random patterns. Fractal technology became widespread in the formation 

of a filtering signal synthesis of three-dimensional computer models of 

natural landscapes, image compression. Quite naturally, the fractal "mode" 

did not spare the theory of antennas. In fact,  the prototype of modern 

technologies in the fractal antenna technology were proposed in the mid-

60s of the last century and log-periodic spiral design. However, in the strict 

mathematical sense, these structures at the time of development were not 

related to fractal geometry, and are, in fact, only the first kind of fractals. 

Now researchers, mostly by trial and error, are trying to use the known 

geometry of fractals in antenna solutions. As a result, simulation and 

experiments showed that the fractal antennas allow the attainment of 

almost the same gain as normal, but in a compact unit, which is important 

for mobile applications. Let’s consider the results obtained in the 

development of fractal antennas of different types. [9] 

The first publications on the electrodynamics of fractal structures are 

from the 80s of the last century. The literature on the history of fractal 

antenna commonly refers to the work of scientists at the University of 

Pennsylvania and Ya.Kima D.Dzhaggarda. Superiority in theoretical 

studies the possibility of using fractal forms to develop multi-band 

frequency antennas is credited to the scientist of the Technological 

University of Catalonia K. Puente (C. Puente). The beginning of the 

practical application of fractal antennas in 1995 was made, as is commonly 

believed, by an American engineer Nathan Cohen. To circumvent the ban 

by Boston authorities to install external antennas on buildings, he disguised 

his radio antenna under the decorative shape formed on the basis of fractal 

sloping described by Swedish mathematician Helge von Koch in 1904 [9]. 

The results published by Cohen of studies of the characteristics of 

new antenna designs have attracted the attention of specialists. Thanks to 
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the efforts of many researchers today fractal antenna theory became an 

independent, fairly well-developed apparatus of synthesis and analysis of 

ESA. 

The prefractal antenna based on the Koch curve became the first 

fractal antenna design with the most complete study of the properties of 

electromagnetic and directed characteristics. When one builds a line 

segment of length Koch original z, called the initiator of the fractal, it 

divides into three equal parts. The central portion is replaced by an 

equilateral triangle with a side of z / 3. The result is a polygonal line 

consisting of four units of length z / 3 each (Figure 1.9). This process is 

repeated for each individual polyline segment: the second iteration on the 

segments z / 3 we construct triangles with sides z / 9, on them  triangles 

with sides z / 27 (the third iteration), etc. 

 

Figure 1.9 The construction of the Koch curve: a) first, b) second c) third, and d) the 

fourth iteration. 

 

Each step of the synthesis increases the length of the resulting curve in 

accordance with the expression: 

   (
 

 
)
 

         (2) 

where n is number of iterations, z is height forming pattern (length of the 

original segment) [9]. 

This effect significantly miniaturize antennas only for the first five or 

six iterations of the fractal. 

Strictly speaking, genuine fractals are not used in antenna solution, 

but a few of their first iterations of forms, given in geometry the name of 

curves. The  term "prefractal” is less commonly used. All these concepts 
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applied to the antenna structure may be used as synonyms. Such 

terminology is historically rooted to the theory of fractal antennas, although 

it does not correspond to the mathematical definitions [9]. 

SFC (Sierpinski Fractal Carpet Antenna) can be used as templates for 

the production of monopoles and dipoles shoulders, forming topology of 

printed antennas, frequency selective surfaces or shells mirror reflectors 

contouring loop antennas and aperture profiles horns and milling grooves 

in the slot antenna [9]. 

There is another delimination of all types of fractal antennas used in 

these segments: lines should be shorter than one-tenth of the operating 

wavelength of the antenna in free space. [9]. 

In general, it should be noted that theoretically the mechanism of 

interaction of fractal antennas and receiving the incident electromagnetic 

wave is difficult because of the lack of analytical descriptions of  wave 

propagation in the conductor with a complex topology. In this situation, the 

main parameters of fractal antennas can usefully be measured by 

mathematical modeling. A lot of work is devoted to the numerical study of 

electromagnetic processes occurring in fractal antennas and in their 

interaction with the objects of the environment. A common drawback of all 

known publications on the results of studies of fractal antennas is the lack 

of guidance on the statistical analysis of the results of experiments. In 

particular, they do not provide information about the confidence intervals 

for the measured parameters, which does not allow to judge the accuracy of 

the result in the empirical relationships. In general, the statistical theory of 

fractal antennas when calculating their numerical methods are still waiting 

for their development [9]. 

After fractal antenna conductors are determined by a complex 

geometry, rather than through the individual components or accumulation 
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of cells (as in the classical antennas), in the latter case the complexity and 

the potential points of failure increase. The analysis shows that there are 

two active areas of research in the fractal technique: fractal aperture, use of 

fractals in designing antenna arrays [11]. 

Fractal antennas allow you to create multi-line options, smaller size 

and often optimal or "elegant" technology of such devices. An undoubted 

advantage of fractal antennas (monopoles and dipoles) is the fact that they 

often have lower resonant frequency than the classical (Euclidean) antennas 

with the same dimensions. Congenital broadband quality fractal antennas 

are ideal for intelligent applications, particularly in the protection of 

information [11]. 

Areas of application of fractal antennas are: modern 

telecommunications, broadband and nonlinear radar systems, searching, 

locating and tracking mobile objects, direction-finding in complex urban 

environments, positioning unauthorized radio sources in the fight against 

terrorists, operational communications in the military markers on various 

subjects, space communications and modern physics experiments [11]. 

It must be emphasized that the modern specialist in the field of 

antenna technology has a great set of analytical, asymptotic and numerical 

methods which allow to analyze the real antenna. And from this point of 

view, research experience allows you to get a physical interpretation of the 

formation of radiation, ie we not only measure the antenna, but are able to 

explain the physics of the antenna. A researcher who is analyzing the 

fractal antenna is in a more difficult situation. He is guided by the principle 

of self-similarity (scaling) for a finite number of iterations. In this case the 

main question is based on which considerations to choose the original 

structure in the analysis of fractal antennas? Therefore, the only research 

tool is the only numerical method and numerical experiment. It is about the 
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same situation that was when classical methods of analysis antennas have 

not yet been developed and had to rely only on the experiment [11]. 

  

1.6 Application and results 

 

Multiband mode of operation, a large overlap of the spectral range 

and bandwidth corresponding to the wavelengths that are much larger 

sample sizes make fractal plate / volume extremely interesting and useful in 

practical applications of frequency selective environment [11]. 

Fractal curves are well known for their unique properties of space 

filling. Recent results have shown that in connection with the increase in 

the total length of the microstrip line on a predetermined region of the 

substrate as well as to the specific geometry of the line, the use of fractal 

curves lowers the resonant frequency of microstrip resonators and gives 

narrowing of resonance peaks[9]. 

Simulations and measurements show that the use of fractal geometry 

significantly reduces the resonant frequency of the structure, and reveals a 

high potential for miniaturization of fractal topologies [8]. 

Extraordinary broadband frequency coverage plus universal compact 

form factors allow fractal antennas to control communication with the 

recognition signals without revealing themselves. Wideband fractal 

antennas contribute to the emergence of advanced mobile tactical 

communications, combining the bandwidth, interoperability, power control 

and compact form [11]. 
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2. Antenna measurement 

2.1 The means of antenna measurement 

 

When measured in the far field antenna in the so-called "anechoic 

chamber" there is an opportunity to create a permanent and comfortable 

external measuring conditions, and also to eliminate interference from 

other transmitters. The chamber walls are covered by special pyramidic 

absorbers to suppress reflections from the walls. Of course, the dimensions 

of the anechoic chamber is not unlimited. To create a flat wave fronts in a 

confined space, you must convert diverging spherical wavefronts in planar 

wavefronts. This spherical wavewfronts are produced by the primary 

sources of signals, which are irradiators. For this purpose we use metallic 

reflectors in the form of one or more concave reflectors, called collimating 

complexes. 

 

Figure 2.1 The main parts of antenna range 

 

Typical antenna range measurement system can be divided into two 

main parts: the transmitting side and the receiving side (see Figure 2.2). 

Transmitting side is comprised of a source of microwave signal amplifiers 

(if required), a transmitting antenna and a means of communication with 
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the host. At the receiving side are located the antenna under test, reference 

antenna, a receiver, a local oscillator frequency downconverter, positioning 

device, system and computer program. [12] 

 

Figure 2.2 A simplified diagram of antenna range far zone. 

 

The very idea of computer modeling of antennas is very attractive: 

drawing on the screen, any configuration of wires and tubes, you can see 

how it will work as an antenna and get all its characteristics. Moreover, we 

can investigate the antenna and change its settings to optimize for specific 

conditions and requirements. After all, it is very difficult or almost 

impossible to measure many parameters of the real antenna. The study also 

provides a computer model of all possible characteristics of the antenna. 

[13] 

A good modeling program is the antenna laboratory, allowing 

inexpensive calculation of the most incredible projects and to get their 

objective data and not anyone's subjective opinion. This powerful training 

system, which you can set almost any questions received mathematically 

precise answer, allowing objectively to compare the different types of 

antennas, and most conclusions. It's also a unique interactive directory - in 
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the conventional paper directory is physically impossible to take into 

account the diversity of opportunities and perform placement of the 

antenna - the number of options in principle is infinite. The application of a 

good modeling of antenna  can answer (exactly your specific) questions 

that otherwise no one will answer. [13] 
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3.Design in ANSYS HFSS 

3.1 Overview of the design 

 

In the modeling of microwave devices, there are many programs that 

offer a variety of approaches to the computer solution of electrodynamic 

problems. The program High Frequency System Stimulator (HFSS) of 

Ansoft, which is designed for the analysis of three-dimensional microwave 

structures, including antennas and non-reciprocal devices containing 

ferrites achieved the most development. Inheriting the best features of 

similar programs implemented in the companies Hewlett Parcard and 

Agilent, it made a significant step forward [14]. 

 

Among the new features Ansoft HFSS can be noted:  

- Periodic boundary conditions for the analysis of antenna arrays;  

- Macro system significantly extends the capabilities of the program;  

- Routine analysis of natural vibrations and natural waves (eigenmode 

solver);  

- Visualizing the results of new possibilities of analysis, in particular, 

animation pictures field build three-dimensional patterns, etc.;  

- Adaptive algorithm for solving electrodynamic problems, providing high 

performance modeling of complex structures;  

- The ability to analyze multiport multimode ports;  

- Extensive database on microwave materials and microwave components;  

- The possibility of parametric analysis and optimization of the structure 

parameters. 

 

In the past 10 years HFSS, during the design period, which was attended 

by the company Hewlett Packard, Agilent and Ansoft, has taken a leading 

position in the world of designing microwave devices. Other programs that 

use electromagnetic methods of calculation are IE3D, Microwave Office, 
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Microwave Studio designed for their classes of problems. HFSS was the 

first of commercial programs to show in full force the opportunities of 

strict electrodynamic simulation [14]. 

3.2 Main characteristics of the package Ansoft HFSS 

 

Electromagnetic Simulation in HFSS is based on using the finite 

element method (Finite Element Method, FEM). The solution of the 

boundary problem is found in the frequency domain. Using the finite 

element method provides a high degree of universality of numerical 

algorithms that are highly effective for a wide range of tasks from the 

analysis of waveguide and stripline structures to modeling complex 

antennas and non-reciprocal devices containing gyrotropic media. [14] 

HFSS allows high accuracy calculation of the external parameters of 

multiport microwave: the scattering matrix, the matrix of impedances and 

admittances. It serves as a basis for integration with other software HFSS 

design implement, for example, solution of nonlinear problems. Calculated 

S-parameters may be used later in the analysis program of linear and 

nonlinear circuits, particularly in application Microwave Office, Serenade 

Ansoft or ADS. HFSS is fully compatible with the platform Ansoft 

Designer, designed for the penetrating design of electronic systems. [14] 

The program has a simple and convenient intuitive user interface 

with which even a beginner can work productively after two hours from the 

first contact with the program. 

 HFSS is a software package for calculating parameters and 

simulation of electromagnetic fields in complex microwave devices. The 

software includes a program drawing three-dimensional objects, the 

calculation program, which includes several methods for solving boundary 

value problems and post-processor for processing and detailed analysis of 

the results. 
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Before deciding the electrodynamic task it is necessary to outline the 

analysed device, set materials for each object, specify the ports and the 

boundary conditions on the surfaces. Then HFSS calculates the 

electromagnetic field at each point under study and finds the structure of 

these S-parameters data and other characteristics. 

HFSS includes a program for calculating the waves of waveguide 

structures and the natural oscillations of microwave resonators Eigenmode. 

This program calculates the resonant frequency of natural oscillations and 

waves propagation constants own structure based on its geometry, material 

properties and boundary conditions. [14] 

HFSS can obtain a solution for a fixed frequency or number of 

frequencies. 

Minimum system requirements to run HFSS v.12:  

System requirements:  

• Operating System: Microsoft ® Windows Vista ® (SP1 or SP2) (32-bit or 

64-bit) Business, Enterprise, Ultimate, or Windows ® XP Professional 

(SP3) or Professional x64 (SP2) Windows Server 2003, Windows Server 

2003 x64 .  

• Processor: Intel ® Pentium ® 4 2 GHz or higher, Intel ® Xeon ™, Intel ® 

Core ™, AMD Athlon ™ 64, AMD Opteron ™, or later.  

• At least 2 GB of RAM.  

• Graphics card-level CAD workstations that supports OpenGL 1.1.  

• Drive DVD-ROM. 

 

 

3.3 Modeling of antennas in HFSS 

 

HFSS calculates basic antenna characteristics, including gain, three-

dimensional pattern in the far-field radiation pattern in the far-sectional 
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area of a beam width of 3 dB (Figure B-6), antenna directivity, gain, axial 

ratio and etc. Polarization characteristics, including field components in 

spherical coordinates, and the polarization vectors of the field are 

calculated. [14] 

In DM and CM wavelengths antennas made by printed circuit technology 

are used. Such antennas differ by reduced weight and dimensions, as well 

as manufacturability.  

Consider the example of the use of package Ansoft HFSS. During the work 

a microstrip fractal antenna was simulated. Optimal parameters for the best 

match with the antenna feeder cable at 2.4 GHz were found. 

Activating Tools> Options> HFSS Options Window: General tab, 

put a checkmark “Use Wizard” for data input when creating new 

boundaries and Duplicate boundaries / mesh operations with geometry 

(Fig. 3) Click OK. 

In the same window, select the option Driven Modal in the Default 

Solution type. The parameter Driven Modal provides calculation of S-

parameters for different types of waves passive structures such as 

microstrip lines, waveguides and transmission lines, which are excited by 

the source. 
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Figure 3.1 Selecting a method for solving the General tab of the dialog box HFSS 

Options. 

 

In the method of solving Driven Modal, HFSS calculates multimode 

S-parameters of passive microwave structures such as microstrip lines, 

waveguides, and other transmission lines. Calculated scattering parameters 

correspond to the standard definition of the energy of the scattering matrix, 

in which both the incident and reflected waves have the dimension of watts. 

Subroutine «Driven Solution» in Ansoft HFSS solves the following matrix 

equation (in the lossless case) 

 

Sx+k0
2
Tx=b ,         (3) 

where:  

S and T are matrices, which depend on the geometry of the partition.  

x is wave solution of the electric field.  

ko is wave number space, b is source value specified for the task. 
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To create the model, create a new antenna design. To do this, 

activate File> New. Then choose the basic parameters: the type of 

environment and measurement units. 

Choose material . Install the unit project: 

Modeler> Units in the Select Units: cm. (Figure 3.2) Click OK. 

 

   

Figure 3.2 Setting the units. 

 

Creating the antenna substrate.  

To define the material and the layer name, one should install from 

the list (Figure 3.3) material of the object  

 

Figure 3.3 Choosing material 
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Activating Draw> Box, using a coordinate line, enter X: -5, Y: -4.5, 

Z: 0.0, press Enter, using the coordinate line, enter dX: 10, dY: 9, dZ: 0.32 

Enter.  

Attribute tab specifies the name Name: Sub1 (Figure 3.4), click OK. 

 

 

Figure 3.4 Writing the name of the box. 

 

Dimensions can be edited by opening the project tree Create Box 

(Figures 3.5 and 3.6) 

 

Figure 3.5 The Project Tree 
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Figure 3.6 The size of a new box 

 

Next drawn rectangle is (with dimensions  x =4cm, y = 3 cm) metal 

mold antenna (patch). And another rectangle (3, 0.5). With a team of Unite, 

combine this with the first rectangle (Figure 3.7). This rectangle is the 

feedline. 

 

Figure 3.7 Rectangle microstrip antenna. 
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Define the boundary conditions for the base substrate and the metal mold 

antenna, this will intensify Edit> Select> By Name, and select the-ground 

and patch.  

Activating HFSS> Boundaries> Assign> Perfect E. Perfect E boundary is 

perfectly conducting surface (metal).  

Define port (Lumped Port), which will be a rectangle drawn in the plane 

XZ (0.5; 0.32). (Figure 3.8) 

Ports are similar to traditional discrete ports wave, but may be 

arranged inside the structure and have a complex impedance, defined by 

the user. Discrete port S-parameters are calculated directly on the ports. 

They are used when performing modeling of microstrip structures. 

 
Figure 3.8 Position of the port on the YZ axes. 

 

Set the default material Vacuum for modeling the emission region. 

Activating Draw> Box (11, 11, 15) - Air (Figure 3.9) 
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Figure 3.9 Air box 

Choose surface Air. Activating HFSS> Boundaries> Radiation, 

Radiation boundary box sets the name Name: Rad1, click OK.  

 

Specify the space radiation activating HFSS> Radiation> Insert Far 

Field Setup> Infinite Sphere. Set up the following values - Fig. 3.10 

 
 

Figure 3.10 Far field radiation sphere setup in HFSS. 
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Input of analys parameters : 

 

Activating HFSS> Analysis Setup> Add Solution Setup and in the Solution 

Setup Window set the following Fig. 3.11 

 
Figure 3.11 Solution setup in HFSS. 

Activating HFSS> Analysis Setup> Add Sweep. On the Edit Sweep 

Window set to Sweep type (discrete, fast or interpolation method): Fast.  

Fast sweep mode is selected if the model will have significant resonances 

or modify performance in the frequency range.  

The fast frequency changes Fast sweep an accurate representation of the 

frequency response near resonance. 

HFSS uses the center frequency in the frequency range to solve the 

problem of finding the eigenvalues, ie a resonant frequency of the structure 

and to generate a solution for performing Fast sweep. In this case, it uses 

the Lanczos-Pade (ALPS) extrapolation in the solution field in the given 

frequency range of solutions at the center frequency of the field. 

HFSS gets all the characteristics of the solutions at the center 

frequency, if it comes in a range of frequencies (greater than the initial 
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frequency and smaller than the final). Otherwise, the center frequency is 

used as a mid-frequency range. [14] 

Procedure for decisions by Fast sweep shown in Figure 3.12. 

 

Figure 3.12-Calculation algorithm used in the method of Fast Sweep 

 

 
 

Figure 3.13-Setting Fast calculation in the frequency range 
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In the same window, select Frequency Setup Type: Linear Count. 

Specify the number or index points in the frequency range. Count value 

includes initial and final values. HFSS will divide the frequency range by 

Count. 

Introduce partition into finite elements on surfaces or objects in the 

three-dimensional volume. This gives information about the maximum 

field strength in the solution domain. 

To do this, highlight the element right-click, select Assign Mesh 

Operations> On selection> Length Based. Leave the default value and set 

OK. "Default" is set to 20% of the maximum length of the borders of the 

rectangles on the boundary of each of the selected surface. HFSS will 

perform successive division faces of elements relating to selected surfaces, 

while their length become equal to or smaller than a predetermined value. 

We perform the same with other elements.  

Before starting the task of the calculation, it is useful to verify that all 

necessary installation was completed, and their settings are correct.  

  Activating HFSS> Validation Check 

 
Figure 3.14 Window-accuracy control of training tasks to the calculation 

 

We proceed to analyze the project. Menu HFSS, click Analyze. The 

end of the calculation will be confirmed in the Message Manager. If there 
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is a problem with the installation of the project, Message Manager will list 

the error or warning messages.  

To create calculated graphs go to HFSS> Results> Create Quick 

Report, select the S parameter, click OK. 

 

Figure 3.15.Frequency response of the input module of the reflection coefficient 

for a rectangular microstrip antenna 

 

Figure 3.15 shows that the antenna is not aligned.  

To improve the antenna matching introduce coplanar coordination. 

Coplanar notches specified rectangle dimensions on a b Figure 3.16. Initial 

size selected in accordance with [15]. Size A corresponds to λ / 4, and b λ / 

8. 
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Figure 3.16 Rectangular antenna with rectangular cutouts. 

 

To fine-tune the use parameterization.  

One of the features of the program is the ability to HFSS 

parameterization and optimization of antenna problems with the module 

Optimetrik (Optimetrics).  

HFSS has a powerful macroteam language allows automatic 

recording and modification. These features are implemented in the program 

Optimetrics, which performs parametric analysis and optimization of the 

structure by changing the shape and size of its elements [14]. 

Program Optimetrics, included in HFSS Ansoft, gives you the 

opportunity to find the best design, changing its geometry, material 

parameters and elements. The design process is first to create the original 

model, or the nominal design, and then set the design parameters that 

change. These parameters can be almost any parameter with a numeric 

value in HFSS. For example, you can parameterize the model geometry, 

material properties and boundary conditions.  
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Using the program Optimetrics, in sizes introduce two parameters a 

and b. In the project tree, right-click the mouse Optimetrics> Add> 

Parametric. 

 

Figure 3.17 Choosing parameterization. 

 

And ask parameterization length and width of the rectangles. (Figure 

3.13) 
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Figure 3.18 Parameterization in HFSS 

 

Expect to get dates and S11: 

 

Figure 3.19. Frequency response of the input reflection coefficient module after 

coplanar coordination 
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Seen from the graph, the minimum value of S11 is achieved when 

possible parameters: a = 1.5 cm and b = 0.35 cm. (Fig.3.20) 

 

Figure 3.20.Frequency response of the input module of the reflection coefficient 

at the optimum size cutouts 

 

Radiation pattern at the resonant frequency is shown in Figure 3.21

  

Figure 3.21 DH-dimensional microstrip antenna at a frequency of 2.49 GHz. 

 

From the Figure 3.21 it is seen that the antenna gain in the direction 

of Z axis at 9.3 dB.  
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As is known from [16] the prevalent method of increasing the width 

of emission band of antenna is injection of gaps to the radiator of 

microstrip antenna. Following the procedure of [16] introduce the gap and 

optimize its width. To further increase the matching quality, we introduce a 

gap in the conductor. Next we will change the width of this gap and 

consider the S-parameter graphs for different values of e - slit width. 

 

Figure 3.22 A microstrip antenna with a slot across the radiating surface. 
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Changing the parameter e from 0.01 cm to 0.15cm increments in the 

frequency range 2-6 GHz, we obtain the following result: 

 
Figure 3.23. Frequency response of the input reflection coefficient module 

parameterized slit width. 

The graph shows that the best agreement with the slit width of 0.15 

cm (Figure 3.24) 

 

Figure 3.24. Frequency response of the input reflection coefficient module with 

parameter e = 0.15 cm 
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From Figure 3.24 shows that the method of [16] allows more 

bandwidth, but at the same resonant frequency shifted to higher 

frequencies. To achieve bandwidth on the original resonance frequency 

requires increasing the size of the emitter.  

Radiation pattern for antenna with a selected slot width at the 

resonant frequency is shown in Figure 3.25: 

 

 

Figure 3.25 Three-dimensional radiation pattern (4.3GHz) 

 

From the Figure 3.25  it is seen that the antenna gain in the direction of Z 

axis at 10 dB. 

 

Due to the displacement of the resonance frequency to higher 

frequencies, with the introduction of the slit was chosen another method of 

creating a broad-band introduction fractality. 
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4 Model with the use of the second and third iteration Sierpinski 

fractal square 

 

Antenna configuration of the radiating surface in the form of the 

second and third iteration Sierpinski fractal curves is simulated (Figure 

1.7).  Dimensions of the radiating surface are taken from paragraph 3.3. 

4.1 The second iteration 

 

Figure 4.1 The second iteration of Sierpinski fractal curves 

 

To determine the best matching Optimetrics introduce the parameter 

g which is coordinate offset port along the x axis. 
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Figure 4.2 The position of the port along the axis X. 

 

G option will move the X-axis from 0.7cm to 0 cm by 0.07 

increments, after analyzing antenna S11 obtain the following result 

parameters: 

 

Figure 4.3 Frequency response of the input reflection coefficient of the module with the 

parameter g-coordinate offset port axis X. 

 

According to the schedule we choose optimal values of g for two 

resonances (by minimality of S11), which is achieved when g = 0 (Figure 

4.4). 
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Figure 4.4-The frequency response of the input reflection coefficient module with 

parameter g=0 

 

From the graph (Figure 4.4) one might observe two resonance 

frequencies at 5.75GGts and 8.52 GHz. Also, compared with a square 

microstrip antenna the level of -10 dB bandwidth is wider for fractal 

antenna. 

Radiation pattern at the resonant frequencies are shown in Figures 

4.5 and 4.6. 

 

Figure 4.5 Radiation pattern frequency 5.75GHz 
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Figure 4.6-Radiation pattern frequency 8.52GHz 

 

And also look at the distribution of intensity at these frequencies, 

respectively 

 

Figure 4.7: Distribution of the frequency 5.75 GHz 

 



49 

 

 

 

Figure 4.8-Distribution of the frequency 8.52GHz 

 

4.2 The third iteration 

 

 

Figure 4.9: The third iteration of Sierpinski fractal curves 

 

We draw from this same antenna port on the optimization of finding 

the axis X. In this case, the parameter will be changed from g=0.3cm to 

0cm with 0.03 increments 
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Figure 4.10 Frequency response of the input reflection coefficient module 

parameterized port location on the X axis 

 

From the graph (Figure 4.10) are seen more pronounced resonances. 

The best agreement is reached at g = 0.21cm (Fig. 4.11) 

 

Figure 4.11 Frequency response of the input module of the reflection coefficient at g = 

0.21cm 

 

Compared with the second iteration, more pronounced resonances 

can be observed in the third. 

Radiation pattern of two resonant frequencies are shown in Figures 

4.12 and 4.13 
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Figure 4.12-adiation pattern frequency (4.57GHz) 

 

 

Figure 4.13-Radiation pattern (6.78GHz) 

 

 

 

As in the previous iteration consider the distribution of intensity at 

the respective frequencies: 
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Figure 4.14-Distribution of the frequency 4.57GHz 

 

 

Figure 4.15-Distribution of the frequency 6.78 GHz 
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Conclusion 

 

In this Master Thesis was investigated the characteristics of the 

selected fractal microstrip antennas. The structure of the Sierpinski squares 

were selected for modeling. When the work was performed the following 

steps of calculation and modeling of rectangular microstrip antenna were 

completed , as well as optimization to obtain the desired characteristics at 

2.5 GHz, modeling and calculation of the second and third iteration 

Sierpinski fractal curve obtained SWR, pattern and intensity distribution of 

these antennas. All results fully meet these technical specifications. We 

have made a search for the optimal position of the port of fractal elements. 

The use of this structure in the emitter of a microstrip antenna allowed to 

expand the bandwidth and gain further resonances while maintaining the 

initial dimensions of a rectangular microstrip antenna. These structures 

have the potential to be used for creating antennas working simultaneously 

in various frequency bands. 

. 
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